
MODULE 5: DESIGN, INSIDE AND OUT 

 

 

“Design should never say, ‘Look at me.’ It should always say, ‘Look at this.’” 

~David Craib 

 

“Don’t let your design resist your readers. Don’t let it stand in the way of what they want to do: read.” 

~Steve Krug 
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Why Design Matters 
The design of your ebook doesn’t necessarily reflect the quality of the content, but we all know that first 

impressions matter, and it’s hard to overstate the importance of good design when creating an ebook. 

This is especially true for ebook covers when you’ll be selling mainly through Amazon, where customers 

may come across your ebook while browsing a category or related item and have only the cover and 

title to make a snap judgment whether to investigate further or move on.  

However, I’d argue that the interior design of an ebook is just as important. For Kindle and Nook 

versions of your ebook, this has to do more with usability, while PDF ebooks offer more options for 

images, fonts and colors, but it’s important for both. The interior design of your ebook affects not only 

its readability, but also adds to the overall satisfaction of the reader, which can contribute to the spread 

of your ideas and additional sales through word-of-mouth marketing! 

 

 

 

 

 

From Jeff & Joy Miller: 

Good design—both the cover and interior—is crucial to an ebook’s success. Sure, there are always 

differences of opinion as to what makes a good cover, but a well-designed cover can often make or 

break the success of a book. Design that appeals to the reader, design that is appropriate for the 

genre, and clearly readable typography are important. Fair or not, books are judged by their covers. 

Read Jeff & Joy’s full case study interview here. 

From Katie Kimball: 

I’m swimming upstream on this one. I DO think design has to help, and in fact I got a new cover for 

the Family Camping Handbook because I was launching on Kindle, and Amazon is very visual with the 

thumbnails at the bottom (“Other people have bought…”). 

On the flip side, I made the cover to Healthy Snacks to Go 15 minutes before I published it using MS 

LiveWriter and two sort of dark photographs. It was literally an afterthought (that I almost forgot 

completely). But that book still sold well, at least making more money/sales than I ever expected at 

the time! My own readers, at least, forgave the horrid cover. It’s still a DIY cover albeit with updated 

photos, although I used a different cover (also free, DIY, from CreateSpace when I published in print) 

on Kindle because it really is more attractive. 

Of the first 4 books, the most expensive cover and first done by a professional designer was Smart 

Sweets…which can’t sell itself for anything. So. In my experience, design is only one piece of the 

puzzle, and not the most important one – but I know MANY will disagree with me. 

Read Katie’s full case study interview here. 

http://fivejsdesign.com/
http://theebookemporium.com/from-idea-to-ebook/case-studies/jeff-joy-miller/
http://kitchenstewardship.com/
http://theebookemporium.com/from-idea-to-ebook/case-studies/katie-kimball/


Of course, bloggers with a large platforms, marketers who are great at networking and creating a 

promotional plan, and writers in popular niches can overcome a less professional cover design through 

those other strengths, as Katie illustrates below. However, I’d argue that if your platform or niche is 

enough to sell hundreds or thousands of ebooks without a beautiful cover or design, your ebook sales 

will only increase with one. 

Even if we all agree that a good cover design is important, the question – like hiring an editor – becomes 

whether you should design your ebook – the cover and/or interior – yourself or outsource it to a 

professional. 

To be honest, designing is one of my favorite parts of the process and not likely one I’ll be outsourcing 

anytime soon. I probably wasn’t very good at it when I started (and it’s always scary to put yourself out 

there and invite criticism by saying you are good at it now), but I’ve gotten better with time, to the point 

that I feel like I can create professional designs on my own. And it helps to be married to a graphic 

designer! 

That doesn’t mean that just because you can do something, you should do it, though. Even if you have a 

design background, like Tsh at Simple Mom, you might want to outsource the design aspects of your 

ebook simply to be able to focus on other tasks that only you can do. But if you enjoy it and can create 

professional quality work, then don’t feel like you have to outsource it. 

It’s also important to acknowledge when design is outside your area of expertise and be able to 

objectively evaluate your designs rather than just throwing together a cover that may not present your 

ebook in the best light. An unprofessional, amateurish cover can give potential customers the 

impression that the content contained within it is unprofessional and amateurish as well, and we know 

that’s not always the case! Be willing to invest in professional designs for your ebooks, and you’ll likely 

see that investment pay off very quickly. 

 

 

 

From Stephanie Langford: 

When I’m making financial decisions like these, such as whether to hire an editor, or a cover 

designer, or someone to format the book, here’s how I think about it. Consider the price point that 

you’ve chosen for your book, and how much profit you actually keep from each sale (after any fees 

you pay, like PayPal, for example). Take the potential cost of that editor or that cover design, and 

divide it by your earnings per book, and you’ll know how many books you need to sell to make up 

that initial cost. I remember with my first book, I was scared no one would buy it and I just 

desperately wanted to recoup the costs that I had put into it. The funny thing is, I made up all of that 

money and more within the first couple days of selling it, back when my blog had a fraction of the 

traffic it has now. After that, it’s all profit and if you’re careful and conservative with those upfront 

costs, it’s easier to make up for than you think. 

Read Stephanies’s full case study interview here. 

http://simplemom.net/
http://www.keeperofthehome.org/
http://theebookemporium.com/from-idea-to-ebook/case-studies/stephanie-langford/


Elements of Good Cover Design 
A good cover design is clear and unambiguous. It is professional, pleasing to the eye and contains the 

title/subtitle and author name in clear, readable type. The goal is really to capture the attention of 

potential customers, to make them want to know more. In essence, your cover buys you the time you 

need to position yourself as an expert and this ebook as one they need. 

 

 

 

When designing your ebook cover, there are several things you want to consider: 

Font(s) 

Finding the perfect font for any design project is more a process of trial and error than anything else, 

and you’ll just want to spend some time trying different fonts on for size to see how they look and feel. 

While a combination of two fonts can really take a design from good to great, going overboard with a 

multitude of fonts actually has the opposite effect, so remember: simple is better! 

Color(s) 

One of the things that often stands out to me when I am putting together bundles for 

BundleoftheWeek.com is the similarities between covers within the same niche. Often the covers will 

look completely different but when you line them up side by side, they actually draw from the same 

color palette.  

I’m not implying that these authors are all copying each other’s ideas but rather that certain colors 

convey specific messages that make them appropriate for a specific niche, and good design takes those 

messages into account when choosing the colors for an ebook cover.  

You’ll find these on the Resources page as well, but my favorite sources for color inspiration include 

Design Seeds and Adobe Kuler. Both of these sites present color palettes, rather than a single color, that 

you can use for inspiration. 

Image(s) 

Almost all book covers include an image of some sort, whether that’s a photograph or an illustration, 

and it’s important to choose a high-quality, relevant image. Your cover tells your reader something 

about your ebook. It sets the mood and gives them an idea of the emotions and ideas you’re trying to 

convey. The image(s) you use play a big part in that! 

From Mindy Harvey: 

I often see DIY book covers that don’t do a very good job at setting the mood for the book. Ebook 

covers should draw you in. The image on the cover should convey how you want your target 

audience to feel about your book. The title should convey what the contents of the book are about, 

but the job of the cover image is to set the mood. Potential buyers should feel like they can relate to 

your book just by looking at the cover image. 

Read Mindy’s full case study interview here. 

http://bundleoftheweek.com/
http://www.design-seeds.com/
https://kuler.adobe.com/
http://simplydesigns.org/
http://theebookemporium.com/from-idea-to-ebook/case-studies/mindy-harvey/


Let’s consider some examples. If I’m writing an ebook about simple organizing solutions for busy 

families, but I choose an image of a gorgeous, Martha Stewart-esque pantry, my potential customers are 

going to receive a mixed message – are these simple organizing solutions for families or beautiful but 

unrealistic systems for child-free households? 

Similarly, if I’m publishing a cookbook, I want to choose a photo that’s representative of the types of 

recipes a reader will find and also makes potential customers’ mouths water!  

 

Images don’t have to be of specific projects, though; they can be more abstract. For example, when 

talking about the cover for Self-Publish, Erin and Teri Lynne say:  

“So why on earth did we choose a photo of a girl swinging above skyscrapers? Seems kind of random, 

doesn’t it? 

In searching for the perfect cover photo, we had several goals: 

 The cover needed to catch the eye of creatives and appeal to their sense of adventure. 

 We wanted to capture the feeling of freedom, the beauty that is self-publishing. 

 We wanted our readers to feel empowered, that they can spread their wings and let their 

dreamed-of books fly. 

Self-Publish is not a particularly technical book. We did not want to communicate that it is. Though it is 

very practical, Self-Publish is, at its heart, about the journey of writing your book, of starting with an idea 

and walking through the process until you have a finished product. It isn’t written exclusively for the 

techie-at-heart. It’s a book for writers; therefore we wanted it to appeal to them. 

We wanted to capture the feeling of launching into the unknown, not with fear, but with excitement. 

We were looking for a photo with that “wow factor.” Not every photo has it. But when you see one that 

does, you can feel it. We wanted our cover to have that impact.” 

Not sure where to find images? Don’t worry; we’ll talk more about finding and using images below! 

http://www.selfpublishthebook.com/


Readability 

And finally, as you tie all of the elements of your cover together, it’s important that the text be easy to 

read, even on the smallest thumbnail. While it may not be realistic to make the title, subtitle and author 

name big enough to read on a 120×160 cover, the title text should be large and clear even at that size, 

and the other elements should be fairly clear at as small a size as possible as well. 

For inspiration, take some time to browse the relevant categories of ebooks at Amazon. You don’t want 

to copy someone else’s design, of course, but seeing what other ebooks in the niche look like can help 

get the ideas flowing and give you an idea of what sells! 

 

 

From Jeff & Joy Miller: 

Problems we’ve seen include using poorly-chosen or low-quality images, being too heavy-handed 

with drop shadows or effects, choosing overused fonts (Papyrus, Bleeding Cowboys, Zapf Chancery, 

etc.), making the fonts difficult to read (the font is too small or scripty), incorporating too many 

different fonts, and including so many elements in the design that the cover is too busy and has no 

focal point. Obviously, there’s more to creating a book cover than finding a vaguely related image 

and slapping some cool-looking fonts on top. 

Read Jeff & Joy’s full case study interview here. 

http://fivejsdesign.com/
http://theebookemporium.com/from-idea-to-ebook/case-studies/jeff-joy-miller/


Elements of Good Interior Design 
While the exterior design of an ebook is mostly for potential customers, the interior design is mostly for 

readers who are reading the ebook (although a sample of the interior can also help move someone 

closer to a purchase decision!).  

This section mostly applies to PDF ebooks, where layout and formatting plays a bigger role in the ebook 

than the more generic ereader formats; however, you’ll find tips on ePUB and Mobi interior design as 

well.  

Things to Consider When Designing Your PDF eBook Layout 
I am a stickler for consistency, and I’d encourage you to make both simplicity and consistency your main 

goals when designing the interior of your PDF ebook. 

I pride myself on creating beautiful ebooks, so I’m not saying that simple has to mean it’s boring with 

just black words on a white page (although I’ve seen some beautiful examples of that type of simple 

layout as well), but you don’t want to get crazy with tons of different fonts (one for headings and one for 

the body of your text is usually enough) or lots of colors either. 

In fact, as funny as it may sound, whitespace or negative space is actually a really important design 

element. Whitespace refers to the parts of the page without text – the page margins, the spacing 

between lines of type, the padding around images and paragraphs. You can get creative with 

whitespace, leaving wide page margins or offsetting the text to one side of the page or the other (and 

the simplest of ebook designs usually utilize whitespace for their aesthetics almost exclusively), or you 

can simply use whitespace to ensure that the ebook is easy on your reader’s eyes – uncrowded and 

scannable. 

 

 
 

Usability for All eBooks 
No matter what format ebook you’re publishing, usability is an important factor to consider. Use 

paragraph and chapter breaks to make it easy to move between sections, an interactive table of 

contents that takes readers directly to the section they’re interested in, and headings to break up the 

text. 

Headings 

One important element of ebook design that applies to both PDF ebooks and other ereader formats for 

From Mindy Harvey: 

As far as formatting goes, simpler is usually better. Sometimes when people are formatting their 

ebooks on their own, I think that they feel like they need to add a lot of extra design and extravagant 

fonts, when it is usually better to just stick to the basics! Readability and functionality are the most 

important things to keep in mind when formatting an ebook. 

Read Mindy’s full case study interview here. 

http://simplydesigns.org/
http://theebookemporium.com/from-idea-to-ebook/case-studies/mindy-harvey/


nonfiction books is the use of headings. Including 1 or 2 levels of headings within your text makes it 

easier for readers to scan the ebook, find relevant sections and refer back to the materials. 

Consistency 

Just like with PDF ebooks, consistency is important for other formats as well. Headings are just one area 

where you really want to focus on consistency, and you should always use headings in a way that’s 

consistent not just within a chapter but throughout the entire book. In addition, check the consistency 

of terms, abbreviations, bullet points, bolding, italics, etc. These may seem like minor details, but they 

contribute to the overall feel and professionalism of your ebook. And as unfair as it is, inconsistency can 

have a much bigger impact than consistency ever does! 

Using Photos and Illustrations in eBooks 
Whether or not you use photos and illustrations in your ebook will depend on the niche and topic more 

than anything else. Most people prefer cookbooks with photos of the completed recipes, and authors in 

this niche often spend as much time photographing their recipes as they do writing the ebook.  

On the other hand, an ebook about writing an ebook doesn’t necessarily need a lot of photos or 

illustrations – perhaps just a few to illustrate a point or walk the reader through a specific process. 

Whether your ebook will have more or fewer images, you want to use quality images (although I don’t 

think that necessarily means professional photographer level images) that are appropriately sized. Be 

careful about stretching small, low-resolution photos to fill space or settling for a mediocre image that 

takes away from the text. 

Also, it’s important to note that images add a layer of complexity to formatting ePUB and Mobi files, but 

for some ebooks, it’s worth that additional work/money. For example, my newest ebook, 101 Days of 

Christmas, will include project photos for all 101+ projects because the photos are an important part of 

the book and I felt like eliminating those from the Kindle version would take away from the overall 

quality and usability of the ebook. 

You obviously don’t have to worry about copyright infringement when you use your own photos, but be 

sure to read the next section about copyright laws before downloading third-party images to use in your 

ebook. 

Including Printables in Your eBook 
As I've mentioned, it's a great idea to add bonus resources such as printables, etc. to your ebook. But 
what is the best way to do that? 
 
There are really three main options: including the printables in the main PDF file, including them as a 
separate download at the time of purchase or having readers visit your site to download them 
separately.  
 
There are pros and cons to all of these, and the best option really depends on how you plan to market 
those printables. In my opinion, if the printable is part of your ebook description -- i.e., "with a printable 
study guide for each chapter" -- then those downloads should be included in the original purchase so 
that users don't have to jump through any extra hoops to get them. The exception would be for Kindle 



books, where it probably makes sense to link them to the site for the download since you can't easily 
print formatted pages from the Kindle or any Kindle apps. 
 
On the other hand, if you're offering those as bonus tools sprinkled here and there rather than part of 
the core of the book and not really promoting those files as part of your sales mantra, I think it makes 
sense to link to a downloads page on your site where readers can find those. This drives additional 
traffic to your site, which is always a good thing as well. 
 
When it comes to actually making the files available for download at the time of purchase, you can 
include the printables in an appendix. Depending on the number of pages, though, it's sometimes more 
user friendly to just create a second PDF with the printables so that less tech savvy readers can just print 
the entire file rather than trying to print only select pages from the main ebook. Both E-Junkie and WP-
eStore allow you the option to offer multiple files with a single purchase, and I've found that doing it 
that way works pretty well! 
 
Caution: Be careful about using .zip folders for multiple printables as opposed to a single download. 
With the increasing number of people who use mobile devices almost exclusively, you may end up 
fielding a lot of customer service emails as they run into issues downloading the .zip folder! 

 



Paying Attention to Copyright Laws 
Please note that I am not a lawyer, and this section is full of my opinion, not actual legal advice. If you 

have any questions about the legality of using a font or image in a specific way, you should contact an 

intellectual property lawyer rather than relying on my interpretation! 

Quite honestly, copyright laws are a bit of a minefield, and navigating those can be stressful because 

there are very real legal and financial consequences for violating those. I say that not to scare you but so 

that you’ll take them seriously, because it can be overwhelming to have to backtrack and check the 

legality of using various fonts and images after the fact. 

Font Licensing 
Recently, an ebook author approached me with a question about using fonts in ebooks and the 

copyright and licensing laws involved in that. For the purposes of this section, we’re going to address the 

cover of your ebook and the body separately, and we’re also going to address Kindle/other ebook and 

PDF files separately.  

First, it’s important to note that most of the time when you’re uploading an ePub or Mobi ebook file, 

you are not specifying a specific font. The ebook is served to the reader according to the settings on 

their device, so questions regarding fonts for the body of an ebook do not apply to those formats, only 

to PDFs. 

Fonts come with different types of licenses that govern your use of the font. Some allow you to use the 

font on your computer to create static images or directly on the web as part of your web design. In 

order to use a font in a static image, it must either be free or available under a creative commons 

license, or you have to have a commercial license allowing you to use it in that way. You’ll find licensing 

information on the page where you download each font, as long as you’re using a legitimate font source 

such as Fonts.com or My Fonts.com.  

These licenses usually refer to personal versus commercial use (and for our purposes, all fonts will be 

used commercially) and the most common options for commercial licenses are Desktop (used on your 

computer within a software program) and Web (used on your website and served to visitors). 

In this example, you can see that KLTTF Grotext offers a desktop license for each version of their font for 

$59: 

 



However, there are many free fonts available for commercial use. The key is to either buy a desktop 

license or choose a font with a free commercial desktop license when designing your cover, ads, static 

elements of a website, etc. FontSquirrel.com offers tons of free commercial fonts, but you’ll want to 

review the licenses of any you use to verify that you understand the terms. 

It’s also important to understand how fonts work in PDF files when choosing a font for the PDF version 

of your ebook. There are really two options: 1) A font file is embedded within the PDF so that whoever 

opens that file is able to view the text in your selected font. Or 2) no font file is included with the PDF 

and the computer finds and displays the font on its own. The second option results in a smaller file size 

but can affect the way a file is actually displayed, so I don’t recommend that option! 

The ebook author who emailed me was concerned she would need a specific ebook license, but my 

understanding from MyFont.com and Microsoft.com is that most Desktop licenses include a Print & 

Preview option that allows you to embed it within the PDF as long as it is not editable. If the font comes 

installed with a software package, you have a Desktop license for that font, and you can actually check 

the permissions available for each font right from your computer: 

Navigate to the font file. Then right click and select Properties. Click on Details and look for the Font 

Embeddability section. The Print / Preview option allows you to embed it in a file such as a PDF that 

prevents the text from being edited, while the Editable option allows you to embed it without those 

restrictions. 

So, long story short (and I’ve spent hours researching this, so this really is the short version!), I feel fairly 

comfortable using the fonts that come with the software I’ve purchased because they all include a 

Desktop license. If you’d like to use additional fonts or play it even safer, search for free fonts or 

purchase a Desktop license for the fonts you want to use. Check the Font Embeddability rights of any 

Desktop license, but most should be okay to embed in a PDF file.  

Image Licensing 
When selecting images – whether those are photos or illustrations – for your ebook, it’s also important 

to pay attention to the licensing issues around each, although these are a bit more straightforward! 

You probably know that you can’t simply find an image (whether it’s a photo or illustration) on the 

internet and use it, and I recommend using a reputable source such as iStock Photo or ThinkStock to 

search for images, since their licenses are fairly unambiguous and they take responsibility for the legality 

of all licenses offered on their site (so you’re not left with a lawsuit for using an image you thought you 

were allowed to use!). Both sites offer standard licenses to use the image for a one-time fee rather than 

a per-impression royalty, and that license includes the right to use it in a PDF file or ebook. 

My general policy is to use my own photos or those that I license through one of the above sites rather 

than free photos from Flickr or other file sharing sites just to cover all of my bases and protect myself, 

but photos and illustrations available under Creative Commons license are another option; just be sure 

to verify the specifics of each license before using the image!  

 

http://theebookemporium.com/from-idea-to-ebook/modules/module-5/
http://www.thinkstockphotos.com/


A Few More Tips 
Finally, here are a few other things to consider when it comes to the design of your ebook: 

Don’t Forget Front and Back Matter 
Front and back matter includes to all the extras that you find in any book – title page, table of contents, 

author bio, synopsis, acknowledgements, endnotes, etc. Not all of these elements will be necessary in 

every ebook, but including the ones that are appropriate not only makes your ebook more user friendly 

but also makes it stand out as a professional publication.  

For a nonfiction ebook, consider these elements: 

 title page – This page includes the title, subtitle and author, and may also include the publisher, 

year of publication and a brief synopsis of the book, often with an illustration but without the 

full cover image. 

 copyright page – If nothing else, your copyright page should include the copyright symbol ( © ), 

date of publication and name of the copyright holder. You may also include the publisher’s 

editorial address, ISBN or identification number, legal notices about your reservation of rights, 

credits for designers, editors, illustrators, etc.  

 ebook synopsis – Because you can’t flip an ebook over to read the back cover again, it’s a good 

idea to include a synopsis toward the beginning of the book so that someone can quickly find it 

when they open your ebook even if they don’t remember what it’s about. This can be done on 

the title page or on its own page. 

 dedication – While a dedication is a standard element in traditional books, you might consider 

leaving it for the acknowledgements section of an ebook so that readers can more quickly get to 

the actual content. 

 table of contents – A table of contents is one of the most important elements you can include in 

an ebook, and it should be interactive, allowing users to click each chapter heading and be taken 

directly to that chapter.  

 foreword – If you’re able to secure a foreword from a well-known author or expert, be sure to 

include that in the front to draw in people who browse the sample and are trying to decide 

whether to buy. 

 introduction – The introduction may include your background, your purpose in writing the 

ebook, your research process, etc., as appropriate. 

 acknowledgements – The acknowledgements are a great place to, well, acknowledge the people 

who have contributed to the ebook directly or indirectly. This could be the support of your 

family and friends, mentor, writer’s group, etc. 

 glossary – If your ebook contains lots of specialized terms, consider including a glossary in the 

front or back matter for readers. 



 index – Although it can be tedious to create, an index can be an important tool for ebooks that 

are packed full of information. 

 appendices (resources, reference lists, etc.) – Your appendices provide bonus information for 

readers and can be a valuable selling point for reference books! 

 bibliography – Although you may have included citations within the body of your text, a 

bibliography is a good place to list all of the books, articles, websites and other sources you used 

for research or referenced throughout the book. 

 author bio – Include your bio in the front or back matter so that readers can get to know you a 

little bit better. You don’t want them just to connect with the book itself but to connect with 

you as an author! 

 promotions/ads for related items – My personal opinion is that this should be left for back 

matter, but don’t forget to include information about other products or services you offer, 

whether those are additional ebooks, coaching, a blog or Facebook page, etc. 

Whether you put each element in the front or back is often subjective (although I think we’d all agree 

that things like the title page go at the beginning!), so consider what works best for your reader – giving 

them the information they need upfront without making it take an hour to flip through all the extras to 

get to the main content!  

Keep in mind also that when samples are generated or downloaded from various retail sites, such as 

Amazon, anything you put at the beginning of the ebook will likely be included, so you don’t want to 

clutter up that space with a lot of unnecessary elements that would do just as well at the end of the 

ebook. 

Creating Your eBook in Word or Open Office 
To begin writing your ebook, you can use a simple word processing program such as Word or 

OpenOffice or writing software like Scrivener. What I like about both of these options is you can actually 

save your document as a PDF file without any additional software. In Word, go to File -> Save As…. In 

that dialogue box, enter your file name and select PDF from the File Type dropdown menu. There is also 

a Save As PDF option on the File menu, but I’ve run into issues with using that option before, so I tend to 

go the slightly longer route to avoid those now!  

In Scrivener, use the File -> Compile option and select PDF from the dropdown menu. I have not 

personally used this option, so I can’t say how accurate or visually appealing the final result is, and you 

definitely lose out on additional formatting options that you’ll find in a more robust word processor. 

If, however, you’ll be working with a designer for the PDF layout or ePUB/Mobi formatting (for Kindle, 

Nook, etc.), you’ll want to send them the Word or OpenOffice file rather than the PDF. And to make it 

simpler for them – and save yourself some money – you’ll want to avoid any fancy formatting in that 

copy of the manuscript.  

Here are a few things to keep in mind: 

 Stick with one space between sentences rather than two. I know your English teacher would be 

appalled, but this really is the standard now for web writing, and ebook formats are basically 



straight HTML, so it applies to that conversion process as well. Extra spaces can actually make 

your text look wonky by adding spaces at the beginning of lines, etc. 

 Avoiding using the tab key to create indents and alignment.  

 Avoid bullet points…or be prepared to pay for them. I’ve actually found in my cookbooks/project 

ebooks that a simple list without bullet points looks just fine, so I simply leave those out 

altogether (although I do include them in my PDF ebooks).  

 Use Heading 1 and Heading 2 (on the Styles menu) to add larger font for chapter titles, 

subheadings, etc. rather than manually changing the font size, adding color, etc.  

 Avoid using text boxes…or be prepared to pay for them. These cannot be automatically 

converted and require extra manual effort on the part of your designer, so avoid them if 

possible, even if you’re using them in the PDF version of your ebook.  

 Use page breaks between chapters, sections, etc. In Word, you can add a page break from the 

Page Layout -> Breaks menu, or simply hit ctrl+shift+enter to insert one at your cursor.  

When to Contact a Designer 
The timeline for each designer will vary from one month to several months, so my recommendation is to 

begin contacting designers at the beginning of your ebook writing process with the following questions: 

1. How much lead time will they need to schedule your ebook project? Be sure to include details about 

what design work you’re looking for (cover, mini site, banners, Kindle formatting, PDF layout, etc.) so 

that they can give you a realistic answer. 

2. What is their turnaround time for the project once you send over the completed manuscript? 

3. What is their design process like? What files will they need from you? How can you better format your 

manuscript to make the PDF layout or Kindle conversion process simpler? 

In my experience, most designers will be able to tell you exactly when they’ll need to have the 

manuscript in order to meet a specific deadline, and if you’re not quite to that point of the process yet, 

they should still be able to give you an idea of how far out you should contact them for various design 

services.   


